
Customer:  MD Anderson 
Project:  3760 – ToxFinder – Running A Trial 
Document:   System User Guide 

 

 

Last Updated: 13-Jun-2005 Reference: NPD/3760/D/SUG ToxFinder – Running A Trial Issue: V1.R2.M1   

Commercial in Confidence Copyright 2005 Tessella Support Services plc Page 1 of  17 
 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ToxFinder – Running A Trial 
Tessella Project Number 3760  

System User Guide 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tessella Support Services plc 

e-mail: post@tessella.com www.tessella.com 

Head Office: Abingdon 

3 Vineyard Chambers, Abingdon, Oxfordshire OX14 3PX, 
England 
Tel: +44 (0)1235 555511 
Fax: +44 (0)1235 553301 
 

 

 



Customer:  MD Anderson 
Project:  3760 – ToxFinder – Running A Trial 
Document:   System User Guide 

 

 

Last Updated: 13-Jun-2005 Reference: NPD/3760/D/SUG ToxFinder – Running A Trial Issue: V1.R2.M1   

Commercial in Confidence Copyright 2005 Tessella Support Services plc Page 2 of  17 
 
  

Document Control 

This document is under document control.  All members of the distribution list will receive updated copies whenever 
alterations are made. 

 

Contributors 

Person Role Company Contribution 

Tom Parke Author Tessella  

Nick Battam Reviewer Tessella  

 

Document Approval 

Person Role Company 

   

   

   

 

Distribution 

Person Role Company 

Peter Thall, Peter Mueller  MD Anderson 

Notes Projects Database 3760   Tessella 

 

Revision History 

Issue Author Date Description 

V1.R1.M0 Nick Battam, Tom Parke 14-Oct-04 1
st
 version written for Alpha release v0.2.6 

V1.R2.M0 Nick Battam 03-Dec-04 Updated for release v1.0.0 

V1.R2.M1 Tom Parke 08-Jun-2005 Incorporated minor updates from Peter Thall 

 

References 

Ref. Document Date Details and Version 

[TMML] “Dose Finding with Two Agents in 
Phase I Oncology Trials” Peter F. 
Thall, Randall E. Milikan, |Peter 
Mueller, Sang-Joon Lee 

Biometrics 
59:487-496, 
2003 

Original paper describing the algorithm. 

[SUG-S] “ToxFinder – Defining and Running 
Simulations” – System User Guide 

 NPD/3670/SUG “ToxFinder – Defining and 
Running Simulations” V1.R3.M0 

 



Customer:  MD Anderson 
Project:  3760 – ToxFinder – Running A Trial 
Document:   System User Guide 

 

 

Last Updated: 13-Jun-2005 Reference: NPD/3760/D/SUG ToxFinder – Running A Trial Issue: V1.R2.M1   

Commercial in Confidence Copyright 2005 Tessella Support Services plc Page 3 of  17 
 
  

Table of Contents 

1 Introduction..........................................................................................................................4 
1.1 Purpose of this document ......................................................................................4 
1.2 Scope of this document .........................................................................................4 
1.3 Context of this Issue ..............................................................................................4 
1.4 Definition of Terms.................................................................................................4 

2 Quick Guide ........................................................................................................................6 
2.1 Starting ToxFinder .................................................................................................6 
2.2 Main Window .........................................................................................................6 
2.3 Exiting ToxFinder ...................................................................................................6 
2.4 Displaying Existing Data ........................................................................................7 
2.5 The Toolbar............................................................................................................8 

3 Creating A Trial ...................................................................................................................10 
4 Trial Manager ......................................................................................................................12 

4.2 Reviewing Trial Data..............................................................................................17 



Customer:  MD Anderson 
Project:  3760 – ToxFinder – Running A Trial 
Document:   System User Guide 

 

 

Last Updated: 13-Jun-2005 Reference: NPD/3760/D/SUG ToxFinder – Running A Trial Issue: V1.R2.M1   

Commercial in Confidence Copyright 2005 Tessella Support Services plc Page 4 of  17 
 
  

 

1 Introduction 

1.1 Purpose of this document 

This document describes how to use the ToxFinder graphical user interface. It is intended for all 
end users of the system. Users are strongly encouraged to read the 2003 Biometrics Paper 
[TMML] before using ToxFinder. 

1.2 Scope of this document 

This guide only describes using the ToxFinder graphical interface and the ToxFinder facilities 
accessible via that interface for running a trial; it does not cover the low level details of the 
ToxFinder model. 

1.3 Context of this Issue  

This issue documents version 1.0.0 of the system released to MD Anderson for review. 

Note: 

• This release has not been approved by the author’s of the [TMML] algorithm as a 
correct implementation of that algorithm.  

• This release has been specifically prepared to allow the author’s of the [TMML] 
algorithm to review the current state of the implementation. 

1.4 Definition of Terms  

ToxFinder is a pair of computer programs that implement the TMML dose-finding algorithm, 
simulate and run clinical trials using the TMML design and provide charts and 
graphs of the results. 

A Simulation Series is comprised of a ‘Design’ for a trial using TMML, a set of one or more 
‘Scenarios’ – possible probabilities of toxicities – and one or more ‘Variants’ where 
some of the Design parameters can be varied to explore the effect of the variation 
on the operating characteristics of a Trial. A Simulation Series creates a number of 
Runs = (number of Scenarios) * (number of Variants). 

A Design is set of parameters that define a trial design to be carried out using the TMML 
method. This consists of: the two dose ranges to be used, lambda - the relative 
cancer killing potential of the two drugs, the prior distribution of the parameters that 
characterise the probability of toxicity as a function of the dose pair of the two 
agents, the cohort size, the sample sizes of the two stages of the trial, the fixed line 
L1 used in the first stage of the trial and the first set of doses to use on L1. 

A Scenario is a set of fixed values of the probability of toxicity as a function of the two agents’ 
doses, x = (x1, x2). We denote this probability by π(x). As x varies over the two-
dimensional domain of the dose pairs π(x) forms a surface that may be illustrated 
graphically. ToxFinder does this, providing a graphical representation of each 
scenario specified by the user. 

A Variant is a small modification to a Design – e.g. different prior, cohort size or study sample 
size. 

A Run A run is a set of all the parameters required to simulate a trial; it is the combination 
of a Design and a Scenario. A Simulation Series consists of one or more runs. Each 
run is organised as a separate folder, all the parameters for a run are held in a 
single file called ‘init.tmml’ and all the outputs for the simulations of the run are held 
in the folder in ‘.csv’ files. (Plain text files with one record per line, individual values 
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separated by commas – this file format is readily imported into many other programs 
such as Excel, Access, SAS and Oracle). ToxFinder can have at most one run 
directory open at any one time and it is the files in this directory that provide the 
source data for the parameter values and visualisation. 

Simulation A simulation is the result of probabilistically generating a single clinical trial using 
ToxFinder. ToxFinder creates data for subjects and their responses by randomly 
selecting from the relevant probability distributions of the scenario defined in the 
ToxFinder input file. A particular run may be simulated a number of times, indeed to 
accurately analyse the characteristics of a particular Design it must be simulated 
usually 1,000-10,000 times over a range of scenarios. 

Trial A trial is a real clinical trial, where the user enters subjects’ data and responses. The 
ToxFinder Algorithm is run to determine the doses to allocate and to analyse the 
results. This facility allows ToxFinder’s adaptive allocation to be implemented to 
conduct small (single centre) trials. 
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2 Quick Guide 

2.1 Starting ToxFinder 

To start ToxFinder, double-click the ToxFinder icon that is installed on your computer desktop.   

After ToxFinder has started, the main window will be displayed. 

2.2 Main Window 

The main window is displayed after ToxFinder has started and is present until ToxFinder exits. It is 
used to open and create designs and to access other parts of the application. 

 

 

 

Initially the only enabled buttons are: 

 

 

 

 

 

These commands are also available from the File menu (along with ‘new trial’). 

2.3 Exiting ToxFinder 

To exit ToxFinder, select Exit from the File menu of the main window. You will be prompted to 
save any unsaved changes that you have made to parameter values. 

Open existing ToxFinder data 

Create new Simulation Series 
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2.4 Displaying Existing Data 

To display existing ToxFinder Data, select Open from the File menu, click the tool button  or 

press the ctrl-o key. If there are currently any open parameter wizard, run manager, Desktop 

ToxFinder or visualisation windows, you will be notified that they will be closed before changing the 
current simulation series and asked if you wish to proceed. 

Use the file browser to select the directory to open and then click the Open button. If you change 

your mind about opening a particular directory then click the Cancel button. As well as folders, the 
file browser displays the ToxFinder input (‘init.tmml’) and output files (‘*.csv’) in each directory to 
help you locate the correct one. 

If the ToxFinder input files contain any invalid parameter values, then you will be notified via a 
message box. These values must be corrected in ToxFinder before ToxFinder can be run with this 
design. 

 

 

In the folder selected for opening ToxFinder will display all its folders that contain ToxFinder data: 
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2.5 The Toolbar 

Once a simulation series has been created, or a pre-existing one has been opened, the 
application’s main panel becomes more interesting: 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Simulation 
Series and 
Trials 

Directory containing the 
set of Simulation Series & 
Trials 

Summary data from 
simulations or actual 
trial 

A Trial being run by ToxFinder 

A Simulation Series 

The design variants of the simulation series 

The scenarios of design variant “20-40”, 
all variants are simulated over the same 
scenarios. 

The currently selected series 

Levels can be expanded or hidden by clicking 
on the ‘+’ or ‘-‘ boxes. 
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Select a simulation series or trial by clicking on its name – the line becomes highlighted. More of 
the ToxFinder Toolbar buttons become enabled:  

 

  

 

 

All of these operations are also available from the application’s menus. 

Right clicking on a Trial or Simulation Series selects it and opens a pop-up menu: 

 

This gives short cuts to commands described elsewhere – it also allows the simulation series (the 
simulation series directory) to be renamed or deleted. 

 

 

 

 

Open a Different Folder 
 

Launch Graph 
Manager 

Save Simulation 
Summary to File 

New Simulation 
Series 

Edit Summary 
Columns 

View 
Simulation 
Data 

Enter Trial 
Data 

Edit the 
Simulation 
Series 

Convert a variant 
or scenario to a 
trial 
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3 Creating A Trial 

A trial design should be simulated before it is run for real, to check that the operating 
characteristics of the trial will be acceptable, see [SUG-S] for the facilities in ToxFinder to support 
this activity. 

At the end of the simulation activity you have a chosen trial design that will be part of a Simulation 
Series – this will either be one of the variants in the series or the sole, ‘default’, version of the trial 
design in that series. To create a trial, simply select this variant in the main screen and click on the 

‘Convert row to a trial’ on the toolbar ( ). 

 

Select a ‘variant’ by clicking on its name. 

You will then be presented with the standard ‘save dialog’:  

 

This allows you to enter a name for a new directory where the trial definition and the subsequent 
trial data is to be stored. 
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Having created the trial you can check, and modify the design by right clicking on the trial name in 
the main screen and selecting ‘Edit’ from the pop-up menu. 
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4 Trial Manager 

ToxFinder provides a facility to manage a trial, with subject data and observed toxicities entered 
manually.  The dose allocation being controlled by the TMML algorithm. 

To open the Trial Manager, click the Manage Trial button ( ), select Manage Trial from the Edit 

menu (Ctrl-t).  These controls are enabled only when a trial row is selected in the summary 

table. 

Each time the trial management window is opened, a dialog is displayed requesting a user name.  
This name must not contain space, comma or single quote characters.  Clicking Cancel aborts 
the operation and returns control to the main application window. There is no checking on the 
name, it is used in the audit log to record who made changes/entered data. 

 

The main Trial Manager window is then displayed. 

This is divided into a number of areas: 

• general controls for navigating the already entered subject data, 

• cohort table that lists all the subjects in the trial,  

• a panel displaying information about the currently selected cohort, 

• controls to manage a trial. 

 

 

To select existing cohorts in the trial, the |<, <, > and >| navigation buttons may be used or a 
Cohort DI number may be typed into the Cohort text box.  Alternatively double clicking a row in the 
cohort table displays that cohort’s details.  The currently selected cohort is highlighted in pink. 

Trail management is divided into 3 steps: 

• creation of cohorts and the allocation of doses 
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• input of observed toxicities 

• display of the recommended trio of dose pairs for further study. 

 

4.1.1 Creation of cohorts and the allocation of doses 

The Add New Cohort button creates a new cohort of subjects and executes the TMML method to 
recommend a dose to assign them.   

 : 

Whilst the program that computes the recommended dose is running (this may take up to a minute) 
an animated ticker is displayed on a dialog.  At any time during the execution clicking Cancel will 
stop the process and return control to the Trial Manager.    

When the calculation finishes the message is updated and the recommended dose pair is 
displayed: 

 

 

Click OK to set the cohort Dose to these values, otherwise click Cancel to ignore the 
recommendation – the new cohort will be set a dose of (0, 0). 

If there is a cohort that has subjects with an ‘unset’ observed toxicity a warning dialog is displayed 
and a new cohort may not be added:  

 

The values in the Dose field must be entered manually if the recommended dose is ignored. 

The ID is a unique number to identify the subject.  If the value entered has been repeated a 
warning is displayed and the value reset.  Each subject is automatically assigned an ID one larger 
than the current maximum, although this may be overridden. 
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There is a second Ident field that may be used to provide something that further identifies the 
subject (e.g. initials, DoB, patient number). These cannot contain spaces, commas or single 
quotes. 

The table lists the subjects associated with the current cohort: 

 

The admission date defaults to the current date.  The TMML algorithm is not time dependent and 
this field is provided simply to assist cross-checking with subject data recorded elsewhere. 

To edit the date or time, click the cell in the table to display a date picker control: 

 

The required time may be set by either typing a new value into the control or selecting the hours or 
minutes component and changing it with the up and down arrows at the side of the control.   

The required date may be selected picking the month from the drop down list, selecting the year, 
either by typing a value into the control or using the up and down controls.  Clicking on a day 
button closes the control.  

The Save Data button writes the current trial subjects to a subject.csv data file.  The cohort panel is 
locked to prevent subject data being edited. Cancel locks the record and resets the data to the 
unedited values.   

Click the Edit Cohort button to switch the panel into edit mode. 

Delete Cohort permanently deletes the currently displayed subject from the trial.  A confirmation 
dialog is displayed to ensure subjects are not deleted in error. 
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4.1.2 Input of observed toxicities 

To enter toxicity results, select the cohort in the cohort table and double click it or press Edit 
Cohort. Initially all the data are locked. 

The Enter Observed Toxicities button unlocks the ‘Toxic’ column of the current cohort to allow the 
observed toxicity results to be entered.  The remaining controls on the panel remain locked. 

Clicking the cell reveals a list of three values that may be set.  If no observed responses are 
available for a subject the value may be set to ‘Unset’; such subjects are ignored when dose 
recommendations are made.  If observed responses are available the toxicity can be set to ‘Toxic’ 
if a toxic event was observed or ‘Not Toxic’. 

 

The Save Data button writes the updated trial subjects data to a subject.csv data file and the 
cohort panel is locked to prevent subject data being edited.   

Once toxicity information is input for each subject in a cohort, a new cohort may be created (see 
above).  The Add New Cohort button is disabled once the final cohort, i.e. the cohort that brings to 
total number of subjects in the trial to the maximum study size (n1+n2), has be admitted to the trial. 

 

4.1.3 Generate Chart Data 

In order to be able to use ToxFinder’s charting facilities (see [SUG-S] for details), the ToxFinder 
model must be run on the entered trial data. To do this simply click on the Generate Chart Data 
button. After a few seconds you should see: 

 

Now when the trial is selected in the main screen, the graph manager button in the toolbar will be 
enabled and the Graph Manager command in the View menu will be enabled. The Graph Manager 
will display the subset of graphs applicable to a trial (as opposed to a simulation): 
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When new cohort data are added the graph manager button and menu command will be disabled 
again until the chart data is re-generated using the Generate Chart Data on the Trial Manager 
dialog as before. 

4.1.4 Display of the recommended trio of dose pairs for further study 

At any point during a trial, the 3 dose pairs recommended by the TMML algorithm for a subsequent 
study, based on the current subject data, may be calculated and displayed by pressing the 
Recommended 3 dose pairs button.   

During the first phase of the trial only a single ‘middle’ value is returned.  Once the second phase of 
the trial is reached three dose pairs are recommended: 

 

 

Middle ( middle
nx ) Lies on the L1 line and contains substantial 

quantities of both agents 

Right ( right↓

nx ) Contains more of agent 1 and less agent 2 

Left ( left↑

nx ) Contains more of agent 2 and less agent 1 

 

This process may take some seconds to complete if the response data have been updated since 
the last cohort was added. 

After the final cohort has been admitted and observed toxicity results entered, the Recommended 

3 dose pairs button will calculate the final trio of doses ( middle
Nx , right↓

Nx , left↑

Nx ) which may be 

studied in a subsequent randomized trial. 

The Close button will close the Trial Manager window and display a reminder to resave the trial 
data if necessary. 
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4.1.5 Audit Log 

All activity is logged in a text file (TrialLog.csv) placed in the scenario directory.  Each entry is 
tagged with time, date and user name. 

The columns in the log file are:  

Column Description 

Date   The date and time of the action.  

User   The user name. 

Action  A description of the activity, one of: 

 New/Edit/Delete Cohort 

or New/Edit/Delete Subject. 

CohortID  Numeric cohort identity. 

Dose Assigned dose pair. 

SubjectID Numeric subject identity. 

Identifier  The subject identifier. 

Admission Date The Admission date of the subject. 

Time The Admission time of the subject. 

Toxic  The observed toxicity for the subject: ‘Toxic’, ‘Not Toxic’ or 
‘Unset’ 

 

For Cohort actions the subject columns are left empty. 

 

4.2 Reviewing Trial Data 

The last trio of recommended doses to be generated (by either the addition of a new cohort or 
displaying the recommended doses), along with the associated P(toxicity) and is uncertainty are 
displayed in the main application table, and as a single row in the simulation data table. 
 
During the first phase of a trial nothing is shown for the ‘left’ and ‘right’ recommended dose pairs or 
their associated P(toxicity) information.  These dose pairs are not defined during the initial phase of 
the trial. 
 


